
PYRAMIX | WORKFLOW GUIDE

DSD & DXD PRODUCTION

INTRODUCTION
Merging Technologies DSD & DXD公式ワークフローガイドへようこそ。このガイドでは、Pyramix Virtual
Studio を使用して DSDおよび DXD コンテンツを録音、編集、制作する方法を説明します。
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WHAT ARE DSD & DXD?
DSDの概要

ダイレクト ストリームデジタル（DSD）は、アナログ信号をキャプチャ（サンプリング）する方法で、標準的なPCM
（パルス符号変調）サンプリング方法とはまったく異なる方法で動作します。

まず、Pcmデジタル・オーディオがどのように機能するかを思い
出してください。

図は、アナログのオーディオ信号をデジタルでキャプチャし、表

現する方法です。波形の振幅は、1秒間に数千回のスライスで
キャプチャされます。キャプチャーが1秒間に何回行われるか
は、サンプルレート（単位はHz）に基づいています。例えば、サン
プルレートが48kHzの場合、振幅測定は1秒間に48,000回行わ
れます。

測定にはそれぞれ分解能があります。これは測定が行われる精度です（ビット単位で測定されます）。16ビット
の測定では、65,535通りの振幅位置の可能性がある。逆に24ビットの測定では、16,777,216通りの振幅位置
の可能性があり、これは非常に大きな増加ですが、それでもアナログオーディオ信号の本質的に無限の振幅位

置の可能性よりは遥かに少ない数です。

つまり、どのように切り取っても、高い周波数で捉えようとしたものを "忠実に"表現するのではなく、原音の近似
値を得ることになります。サンプルレートが高くなればなるほど、この事実を最小限に抑えることができます。

ナイキストとローパスフィルター

PCMオーディオの他の "問題"の一つは、サンプリングする前にローパスフィルターを通す必要があることで
す。これは、"ナイキスト"効果のためです。オーディオをデジタルでサンプリングする場合、より高い周波数の
オーディオをキャプチャしようとすると、ある時点以降、デジタルコピーに若干の可聴歪みが生じます。これは周

波数がサンプルレートの半分以上の信号をサンプリングすると、信号が誤って表現されるために起こります（画

像参照）。

PCMで動作させるためには、高い周波数がサンプルモジュー
ルに到達しないように、ブリックウォールフィルターを設置する

必要があります。

44.1 kHz（レッドブック、オーディオCDのサンプルレートの標
準）の半分は22.05 kHzで、これは人間の平均可聴域を超えて
いますが、これらの超音波周波数と倍音は、人体がまだ「感じ

る」ものであり、もし存在すれば、音をより「楽しく」「リアル」にす

ることができます。
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周波数応答：何をキャプチャしているかを見る別の方法

私たちが音に耳を傾けるのは音色だけではありません。私たちは超高速で超短いノイズも「トランジェント」として

聞いていることになります。例えば、ピアノの鍵盤を叩く音とギターの弦を弾く音の違いを判断するのに役立つク

リック音や破裂音です。フレットノイズや弦を弾くときの爪の音は、アナログの世界では簡単に聞くことができま

すが、周波数が高いため、低いデジタルサンプリングレートで捉えるのは非常に困難です。

DSDはどのように機能するのか？

DSDは上記の方法とは全く異なる。1秒間に何千回というビット数の詳細な振幅測定を行うのではなく、1秒間に
何百万回という1ビット（1ならアップ、0ならダウン）の信号の振幅の変化を、単純に記録します。

負帰還ループを使用し、1対 0の密度を見ることによって、この 2値データから信号を推定することができます。

上の図は、信号がどのようにキャプチャされるかを簡単に視覚化したものです。

アナログオーディオストリームをデジタルキャプチャーするこの方法では、周波数特性だけでなく、DSDを本物
のアナログと同等にする他の多くの要素において、非常に大きく改善していることを意味しています。
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DSD64, DSD128, DSD256：選択肢が増えた？

Pyramixは 3種類の DSDを装備しています。それぞれの数字は「FS」で、「frequency (sub-script) sampled」
の略です。1 FSは 44.1/48 kHzのサンプリング周波数を表します。2 FSは 88.2 /96 kHz、4 FSは
176.4/192 kHzです。つまり、DSD64は CDのサンプリング周波数の 64倍である 2.4MHzに相当します。
DSD256は 11.2 MHzで、1秒間に 11,200,000サンプルということになります。

DSD64 (64x CD Sampling Frequency) = 2.8224 MHz
DSD128 (128x CD Sampling Frequency) = 5.6448 MHz
DSD256 (256x CD Sampling Frequency) = 11.2896 MHz

ここでの選択は、PCMフォーマットを選ぶときと同じです。ドライブの空きスペースや処理能力、クリエイティブな
意図で、より大きなDSDフォーマットを使うか、より小さなDSDフォーマットを使うかの決断をします。

DSDにおけるノイズシェーピングと超高周波ノイズ

一度アナログに変換された DSD信号を見ると、
超高域のレベルが大きく上がっていることが分かり

ます。DSD信号のノイズスペクトラムが 22kHz以
上で増加するのは、主要なオーディオ帯域である

20Hz～20kHzのダイナミック レンジ 120dB を得
るためにノイズシェーピングが行われているから

です。これはサンプリング時に信号に追加される

ディザーのようなノイズであり、元のオーディオスト

リームの同じ超高域を扱う際の量子化誤差を防ぐ

だけですので、心配する必要はありません。DSD
の "タイプ" を選択する際に注意しなければならな
いのは、より高いDSDレートでは、このノイズがさ
らに高い周波数に押し上げられるということです。

DXDとは？

DXD（Digital eXtreme Definition）は、Merging Technologies社が特別に開発した PCMサンプルレートで
す。DXDは 352.8kHz/24bitのオーディオ信号で、DSD信号をPCM（オーディオをデジタイズする標準的な方
法）の世界にシームレスに移動させ、EQやダイナミクスなどのエフェクト処理を行うために使用されます。
DSD256, DXD そして地球上で最もトランスペアレントなSRCでサンプレート変換を自動的に行うことができるタ
イムラインの組み合わせが、Pyramix を最もサウンド的に印象的なワークステーションにしています。

DSDの何が問題なのか？

DSDは 1と 0として存在します。このことは、前のセクションで説明したような理由で、信号を録音したり再生した
りするのには最適です。しかし、その信号に何かを "しようと"すると、すぐに大きな問題が生じます。基本的に
DSDは純粋なデジタル ドメインでは "ミックス不可能" だということです。
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例えば、ファイルのゲインを変更したいとしましょう。ゲインを変更するには、各サンプルのパーセンテージを計

算して、新しいゲイン "レベル"に到達する必要があります。1と0しかない場合、それは不可能です。しかし、こ
の制限には DXD という解決策があります。

Pyramixは DSDとDXDのフォーマットをその場（オンザフライ）で変換することができます。

● DSDファイルでフェードやクロスフェードを行った場合、Pyramixはフェード部分をリアルタイムでDXD
に変換して編集を計算し、出力段階でDSDに再変調します。

● Pyramixのレンダリングツール（CedarやAlgorithmix ReNOVAtorなど）は、デスティネーションフォー
マットがMTFFの場合、処理する範囲だけの DXDバージョンを作成するだけですので、DSDファイル
で使用できます。

● DSDプロジェクトを "DXD Mixing Mode" で開くと、ミキサーと192kHz以上のサンプルレートで動作す
るプラグインにフルアクセスできます。DXDに対応しているVSTは限られていますので、DXD対応プラ
グインリストをご覧ください。

DXDは、このような高いサンプリングレートで高度な編集やデジタル ミキシング機能を使用するためのMerging
のソリューションです。

DXDは DSDにだけに使われるのですか？

そんなことはありません！ DXDは多くの分野で制作やマスタリングに使用される非常に一般的なサンプル
レートフォーマットです。例えば、いくつかのクラシック音楽レーベルは、SACD と純粋な DXDデジタルバージョ
ンの両方をリリースしています。DXDはまた、意図やワークフローに応じて、制作プロセスで好まれるフォーマッ
トでもあります。このトピックについては、次のセクションで取り上げます。

MAKING THE CHOICE:
DSD, DXD OR DSD IN DXD
ワークフローの選択とそれが意味すること

dsp Japan Ltd, 4-8-5 Nakameguro, Meguro-ku, Tokyo 153-0061

T : 03-5723-8181 F : 03-3794-5283 U : http://www.dspj.co.jp

5

https://confluence.merging.com/display/PUBLICDOC/DXD+Compatible+Plugins
https://confluence.merging.com/display/PUBLICDOC/DXD+Compatible+Plugins


DSDで作業する

● ファイルはA/Dコンバーターから直接 DSD信号として録音されます。
● プロジェクトのミキサーは固定され、信号に影響を与えたり、トラックをミックスしてバスに出力すること

はできません。

● タイムラインの一部を編集することができます。この方法では、触ったものすべてがDXDに変換され、
編集処理後にDSDに再変換されます。編集していないものだけが純粋なDSDとなります。

● タイムライン上のファイルの位置に基づいて最終マスターを作成することができます。

○ トラック 1と 2を埋めると、ステレオマスターが作成されます。
○ トラック 1-6を埋めると、5.1マスターが作成されます。

■ サミングバスを使用してファイナルマスターを作成することはできません。

この方法を使う目的：

● DSDピュアリストであり、レコーディングをできる限り "そのまま"の状態で残したい場合。
● アナログマスターをキャプチャーして、"デジタル化"する以外のことはしたくない場合。
● マイク配置のエキスパートであり、マイクを「あるべき場所」に正確に配置することで録音に命を吹き込

むことができるため、ミックスしたり録音したものに影響を与えたりする必要がない場合。

● ミキシングにアナログ機器を使用しているので、DSDプレーヤー／レコーダーで十分な場合。

DXDで作業する

● ファイルは DXD信号としてA/Dコンバーターから直接録音されます。
● PCMの世界に存在するように、ミキサーとすべての編集ツールにフルアクセスできます。
● すべての編集とレンダリングはDXDサンプルレートで行われます。
● サミングバスを使用して最終的なマスターを作成できます。

● これらのマスターは DXDと DSDレートのファイルになります。DSDレートのファイルの場合、ミキサー
出力で DXDから DSDへの変換が行われます。

この方法を使う目的：

● 録音した後、そのサウンドに手を加えることになることが分かっている場合（編集、イコライジングな

ど）。

● 制作中に Pyramixミキサーを使用してミキシングを行う場合（アーティストへのキューセンドなど）。
● SACDへの仕上げが必要な場合（マスタリング段階でDXDからDSDに変換する）。

DXDプロジェクトでDSDを扱う

● ファイルは A/Dコンバーターから直接 DSD信号として録音されます。
● ミキサーとすべての編集ツールにフルアクセスできます。

● タイムラインの一部を編集することができ、編集したものはすべてDXDに変わります。編集せずに残っ
たものだけが純粋なDSDになります。
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● サミングバスを使用してファイナルマスターを作成できます。

● これらのマスターは DSDレートのファイルにすることができます
○ ミキサーの出力でDXDからDSDへの変換が行われます。

この方法を使う目的：

● 録音ファイルの形式を重視し、DSDにしたい。
● プロデューサー用のミックスとアーティスト用のキューセンドを提供するために、レコーディングプロセ

スで DXDミキサーを使用しているが、最終マスターでは高度なミキシング機能を必要としないため、編
集時に DSDモードに切り替えたい場合。

DSD 64 / 128 / 256 どの方法を選ぶか

どの方法を選択をするかの決断が必要です。DXDのプロセスなしで SACD を作るつもりですか？

もし答えが Yes なら、タイムライン上のメディアが DSDIFF DSD64 であることを確認する必要があります。そ
れ以外のものは、Render Mode で SACD を制作することはできません。
しかし、DSD CONVERTER アプリを使って、最終段階で DSD128 または DSD256から DSD64にダウンサ
ンプリングすることはできます。

選択の後、使用するディスク容量、提案された成果物のサンプルレートなどの通常のパラメーターに基づいて、

残された選択肢を検討することができます。

上記について決断を下す際に問うべきは、次のようなことです：

● 最終の製品は何になる予定ですか？

○ SACD
○ DSDまたは DXDデジタルダウンロード
○ "標準" ファイル（CD、MP3/AACなど）
○ 上記のすべて

● DSD -> DXD -> DSDの変換を最低限にするにはどうすればいいですか？コピーのコピーは可能な
限り避けるべきです。DSDファイルが Pyramixで処理されるたびに再変調が発生し、そのために超音
波ノイズが追加で発生してしまいます。

● PC内でミックスする必要がありますか？
● 録音は特定のフォーマットで保存する必要がありますか？

メータリング と レベル

SACDと DSDの制作には、周波数帯域のさまざまな帯域で、非常に特殊なメーターとレベルの要件がありま
す。SACDの製造工場では、正しく適合しないマスターは受け付けてもらえないため、不要な余分な作業を避け
るために、メーターリングを適切に設定する必要があります。
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最終的に DSDメディアになるすべてのプロダクションにおいて、これらのメータリングスケールに従う必要があ
ります。つまり、SACDディスクだけでなく、デジタルダウンロード用の DSDファイルも含まれます。これらのガイ
ドラインに従う必要がないのは、DXDで作業し、DXDマスターで仕上げる場合のみです。

まず、dBSACDについて知っておく必要があります。dBSACDスケールは dBFS（フルスケールまたは録音
可能な最大のデジタルレベル）に関連していますが、SACDの本当の最大レベルに達する前に「安全地帯」を
可能にする異なる 0 レベルを持っています。以下の表をご確認ください。

DSD を扱うときの Pyramix ミキサーのメーター表示

**重要なNOTE **

DSDプロジェクトで作業している場合、Pyramixのミキサーは dBSACDの表示に変わります。プロジェクトの
DXDバージョンと DSDバージョンを切り替えると、メータリングもそれに合わせて変更されます。

20Hz - 20kHzの範囲（SACD SCARLET BOOK ANNEX D3）

可聴帯域において、SACDの仕様では、最大レベルは 0dBSACD です。これを基準として、SACDは
+3.1dBSACDに "一時的な" ピークを合わせることも許されています。

しかし実際には、+3.1dBSACD を使用すると問題が発生する可能性があります。ピークに達する （またはピー
クが大幅に制限される）ため、SACD製造施設によって拒否される可能性があります。

SACDレベルに関する2つ目の警告は、Pyramix ミキサーのメーター（ピーク メーター）は、正確な機器ではない
ということです。特にDSDプロジェクトでメーターを使用する場合、最大で +/-1 dBの誤差が生じる可能性があり
ます。Pyramix環境で実際の最大のDSD信号は、+1dB-SACD以下であるべきです。

40 khz -100 khzの範囲（SACD SCARLET BOOK ANNEX D4）

DSDでは、高域をすべて除去するフィルターが存在しないため、SACD仕様でもこの範囲を考慮するよう求めら
れています。

SACDの仕様では、40k - 100kHzの周波数帯域は -20dB SACD を超えてはならないとされています。
これをチェックするには、All Settings > Mixer Settings > Level Meter で DSDフィルターを 40 - 100kHz
に変更します。

***NOTE***
DXDプロジェクトでは、出力バスにVS3プラグインの VU を入れ、40 - 100kHzの帯域を表示するように設定
することができます。これにより、チャンネルメーターは 0 - 20kHzの帯域をモニターできるようになります。
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VUメーターを開き、UIの中で右クリックしてください。DSDタブの中で 40k - 100kのバンド を選択してください。

DCオフセット（SACD SCARLET BOOK ANNEX E）

SACDの制作では、DCオフセット レベルも重要です。SACDの仕様では、DCオフセット レベルは
-50dBSACD を超えてはならないとされています。これは最新の SCARLET BOOKから削除されましたが、
参考として記載しておきます。またワークフローに関係なく、オーディオにDCオフセットがないことを確認するこ
とは、一般的なことです。

TIP：メーターの設定とDCオフセット

PCMであれDSDであれ、DCオフセットのチェックはすべてのレコーディングで行うべきです。マスターに DCオ
フセットが存在すると、ヘッドルームの減少につながるだけでなく、視聴者のスピーカーに害を与える可能性があ

ります。Pyramixには DCオフセットメーターがありますが、他のプラグインと同様、DSDでは機能しません。

そのため、まずDXDプロジェクト（デフォルトのものであれば何でも構いません）を作成し、すべての入力ストリッ
プに VS3 DC Offset Meter を入れて、DCが存在するかどうかを測定することをお勧めします。レコーディング
を始める前にこの作業を行う理由は、レコーディング後にDCオフセットを除去するには、DXDに変換してから
DSDに再変調するしかないからです。ほとんどの DSD愛好家がやりたがることではありません。

Merging社製 IO インタフェースを使用する場合

Merging社製のネットワークオーディオ インターフェイスを使用しているのであれば、上記のような DCオフセッ
トについて心配する必要はありません。DC除去ユニットがコンバーターの全入力に入っているからです。

DSD コンピュータの選択
Pyramix ソフトウェア と DSD/DXDついて話す前に、まず、ある人にとっては当たり前のことに思えるかもしれ
ませんが、単刀直入に述べておきたいことがあります。

DSD/DXD を適切かつ問題なく扱うには、非常に優れた強力なワークステーションが必要です。

Merging Technologies社は、DSDとDXDに対応した ターンキーコンピューターシステムを、ラックマウント型
と静音デスクトップ型の両方で特別に設計製造していることをお伝えしておきます。

DSDやDXDシステムをセットアップする際には、ファイルのサイズ、必要なハードドライブのスピード、リアルタイ
ムの処理能力など、様々なことが重要です。Merging社製のPCを使用しないのであれば、PC設定ページを必
ずチェックしてください。
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MASSCPRE と NATIVEのどちらを使うか
最近のコンピュータはパワフルですので、NATIVE プラットフォームでもある程度の DSDや DXDの作業が可
能ですが、MASSCORE システムほどではありません。

パフォーマンスの違いを簡単に説明します：

NATIVE MASSCORE

Max Track Count Max Track Count

DXD 8ch
Merging I/O と
Merging ASIO Driver
の使用で 16ch

DXD 64ch
Merging II/Oのみ

DSD 64/128/256 8ch
Merging I/O と
Merging ASIO Driver
の使用で 16ch

DSD 64/128/256 64ch
Merging II/Oのみ

Latencies Latencies

Minimum Latency 48 Samples（AT-ASIO
v11）

Minimum Latency 32 Samples

VS3 Plugin Latency Additive VS3 Plugin Latency Included

Limitations in Recording Limitations in Recording

● DXDプロジェクトでDSDファイルは録音
できない

● 無し

Limitations in Mixing Limitations in Mixing

● 無し ● 無し

各ソフトウェアパックの詳細については、当社のウェブサイト をご参照ください。

DSDや DXDのシングルサラウンド レイヤーの録音と編集を行い、ヘッドフォン フィードなどを提供する必要
がなければ、Native で十分でしょう。しかし、トラック数が多く、プラグインを使用してもレイテンシーが低いレ
コーディング、編集、ミキシング機材が必要な場合は、MassCoreが最適です。
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PYRAMIX CONFIGURATION
Pyramix をインストールしたら、DXD/DSD用に設定するためにいくつかのステップがあります。Pyramixは
様々なアプリケーションに最適なツールになるように設計されているため、1- 2分余分に時間をかけて、
Pyramix で何を行いたいかを設定する必要があります。

AUDIO ENGINE CONFIGURATION

VS3 CONTROL PANEL

Pyramixはオーディオエンジンをセットアップするために、Pyramixのメインアプリケーションの外側にある小さ
なアプリケーションを使用します。VS3 Control PanelはWindowsのコントロールパネルからアクセスでき
ます。

DSD / DXD作業用の NATIVE システムのセットアップ：

MassCore エンジンを使わずに Pyramix を使用する場合、"Native
mode” を実行することになります。PyramixはホストPCのCPUを、
その時に起動している他のアプリケーション（Microsoft Wordなど）と
共有することになります。"Native mode” で実行するには、Pyramix
をPCの専用サウンドカード出力を使うか、”ASIO” を使うオーディオ
インターフェイスをコンピュータに接続してセットアップします。

お使いのオーディオインターフェイスがASIOに対応しているかどうか
は、箱や取扱説明書のどこかにWindowsのロゴが表示されていれ
ば間違いありません。現在入手可能なインターフェースの約99％は
互換性があります。しかし、DSDやDXDに対応しているオーディオ イ
ンターフェイスはごく一部です。また、Pyramix Nativeは録音時に
DSDをDXDに変換することができないため、DSDを録音するには
DSD Project を実行する必要があります。

したがって、お使いのインターフェースがDXDおよび/またはDSDに
対応し、Pyramixで動作することを確認してください。100%確実を期
すには、インターフェースのメーカーに問い合わせてください。
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ASIOオーディオ インターフェイスへの接続（ASIO インターフェイスが正しく動作するには、DSDまたはDXDに
対応している必要があります）

● 現在承認されテストされている DSD DACのリストが必要な場合は、Merging Tech-nologies社にお
問い合わせください。もちろん、Hapi または Horus（Merging社のフラッグシップ DSDおよびDXD対応
ネットワークオーディオ コンバーターシリーズ）をお勧めします。

● デバイスのドライバのインストーラをダウンロードします。

● インストールしてください。

NATIVE システム用 VS3 CONTROL PANELの設定

1. Applicationのドロップダウンで “Pyramix”が選択されていることを確認します。

2. Platform で "Native- ASIO" を選択し、ASIOドライバを選択します。

3. ASIO Device Bridge Modeの設定：
Disabledに設定してください。これはDSDとDXDの作業には使えない機能です。

4. APPLY をクリックし、VS3 CONTROL PANEL を閉じます。

SETUP FOR A MASSCORE SYSTEM

Native システムの場合と若干異なりますが、MassCore エンジンを使用するには、まず MassCore エンジンを
システムにインストールする必要があります。詳細については、Pyramixのインストールガイドをご覧ください（
Webサイトから入手可能です）。

VS3 CONTROL PANEL を開き

1. Applicationのドロップダウンで "Pyramix"が選択さ
れていることを確認します。

2. Platformに “MassCore” を選択します。

3. ASIO Device Bridge Modeの設定：
Disabledに設定してください。これはDSDとDXDの
作業には使えない機能です。

4. Merging RAVENNA Network Interface Card
(NET-MSC-GBEX1)を On Busにします。

5. APPLY をクリックし、VS3 CONTROL PANEL を閉
じます。
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STARTING YOUR FIRST PROJECT
このセクションでは、前に説明した 3つの動作モードを設定する方法を説明します。

以下の章についての注釈

DXDは PCMフォーマットであるため、DXDで作業する際に考慮すべき特別な点はありません。そのため、ハイ
レゾのセットアップ、レコーディング、編集、ミキシング／マスタリングのコンセプトに関する章では、特別な配慮

が必要となるDSDでの作業についてのみ説明します。DSDファイルを制作する必要がなく、DXDのみを制作す
る場合は、他のPCMサンプリングレートとワークフローは同じです。

純粋なDSDプロジェクトの設定

DSD Projectは操作方法が制限されています。これはDSDが "MIX" できないためで、このセクションでDSD
Project を作成すると、その中のトラック数を修正することはできません。そのため、トラックを追加する必要が
ある場合は、新しいプロジェクトを作成し、最初のプロジェクトから Media を Copy & Pasteする必要がありま
す。

既に編集を行っている場合は、Library を使って、トラック数の多いプロジェクトにファイルを送ることができます。
新しい Globak Library を作成し、タイムラインで必要なクリップを選択し（すべてのクリップを選択するには
CTRL+A）、ALT+SHIFT を押したまま選択範囲をライブラリ内にドラッグします。このライブラリをトラックの多
いプロジェクトで開き、Libraryに入れたものをタイムライン上にドラッグしてください。

PROJECT > NEW

STEP 1 : PROJECT TYPEの選択
DSDを選択し、作業したいDSDのタイプを選択し
ます。Render mode を使ってSACDを制作した
い場合は、DSD64 /2.8 MHzを選択する必要があ
ります。

STEP 2 : WORKSPACEの作成
チェックボックスをオンにします： Setup a new
Project Workspace（新しいプロジェクト・ワーク
スペースをセットアップする）"にチェックを入れる
と、新しいプロジェクトに名前を付け、プロジェクトと

メディアファイルの保存場所を選択できます。プロ

ジェクト名を入力し、有効なパスを入力するか、

[Browse]ボタンを使用して適切な場所を決めてく
ださい。入力が完了したら、"Next"ボタンをクリッ
クして次のステップに進みます。

ステップ 3: CHOOSE A MIXER
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新しいプロジェクトには、Mixerが必要です。Mixerは、タイムライントラックの種類（mono/stereo など）と数、
およびサミングバスを設定するために使用します。しかし、純粋な DSD プロジェクトの場合、この設定は限り
なくシンプルになります。つまり DSD Mixerは、モノラルストリップをモノラルバス出力に出力するだけです。

● Default Mixer：デフォルトのミキサー： DSDプロジェクトでは適用されません。
● Mixer Wizard（ミキサーウィザード）： 新しいウィザードが開き、録音するDSDトラックの数を選択でき

ます。

● Use Preset：純粋なDSDワークフローでは関係ないので、グレーアウトされています。

それでは Mixer Wizard を選択してトラック数を設定しましょう。

MIXER WIZARD

MIXER WIZARD を選択すると、MIXER WIZARDが開きます。最初のページ（Welcomeページ）が終わる
と、次のページが表示されます。

作業したいDSDトラックの数を入力し、"Next"をクリックしてくださ
い。

I/O Routingページは、自動的に物理 I/O を Mixerの Input
Strip と Output Busに接続しようとします。

トレーニングのため、またミキサーの基本的なコンフィギュレー

ションを練習するときは、このボタンが押されていないことを確認

してください。以下のセクションでは、物理 I/O を手動でミキサー
に接続する方法を説明します。

ピュア DXD PROJECT と DSD IN DXD PROJECT を作成する

DXD Projectは（バックグラウンドでDSDをレコーディングしていても）"通常の" PCM環境と同じように動作す
るため、このセクションでは Mixer Stripや Busの配置を様々なタイプにすることができ、選択の幅が広がりま
す。

STEP 1：プロジェクトのタイプを選択する
DXD Mixing Project を選択し、"Next" をクリックします。

STEP 2：新しいプロジェクトのワークスペースを設定する
チェックボックスにチェックを入れます： Setup a new Project Workspace（新しいプロジェクトワークスペー
スをセットアップする）にチェックを入れ、プロジェクトに名前を付け、プロジェクトとメディアファイルの場所を選

択することができます。

プロジェクト名を入力し、有効なパスを入力するか、Browseボタンを使用して適切なフォルダを参照します。入
力が完了したら、Nextボタンをクリックして次のステップに進みます。
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STEP 3：ミキサーの選択
Projectには、適切に設定された Mixerが必要です。Mixerは、タイムライントラックの種類（mono/stereo な
ど）や数、サミングバスを設定するために使用します。繰り返しますが、DXDは（DSDを録音する場合でも）標準
的なPCMプロジェクトのように動作しますので、Busや Strip を自由に追加することができます。

● Default Mixer：デフォルトとして設定されているタイムラインとミキサーが作成されます。
● Mixer Wizard：現在のウィザードで "Finished"をクリックすると、Mixer Wizardが開きます。
● Use Preset：表示されるリストからミキサーを選択します。

このガイドでは Mixer Wizard をクリックして次のステップに進んでください。

MIXER WIZARD

MIXER WIZARD を開きます。Welcome メッセージの最初のページに続き、図のページが表示されます。

この Masters Configurationページでは、これから
作成する Projectのサミングバスの数と タイプを選
択します。

以下に、各タイプの説明と、それを使用する理由を説

明いたします。

SACD制作にマルチチャンネルバスを使用する場合
は、最終段階でのチャンネルマッピングの問題を避け

るため、5.0 または 5.1 SMPTE を使用する必要があ
ります。

TYPE選択に関する説明

BUS VS GROUP：
● BUSは、出力を物理的な出力（I/O）に送るマスターのことです。
● GROUPは、他のマスターにルーティングできるマスターです。

AUX VS MIX
● Auxは、各ストリップにゲイン調整があるマスターで、信号の一部をサミングに追加するために使用し

ます。AUXは、通常アウトボード機器やプラグインへの FXセンドや演奏者への送りに使われます。
● BUSは、ON/OFFのパラメーターだけを持つマスターです。ステム ミキシングやミックス全体をモニ

ターするためのメインミックスバスを作成する際に、各プレイバックストリップの全レベルがステムに供

給されるようにしたい場合（つまり、すべてのダイアログ トラックがダイアログステムにノミナルレベルで

供給される必要がある場合）、またはファイナルミックスに使用されます。

どのような場合にバスやグループを使うのか？

以下は GROUP（Aux / Mix）の使用例です：
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● Aux Groupは、Aux Group Masterに置かれた Reverbプラグインに信号を送る場合に使用しま
す。

● Aux Busは、ナレーターにヘッドフォーン送り返しをする場合に使用します。
● Mix Groupは、Stem を作成し、ステムミキシングを行う場合に使用します。これらのステムは、最終

ミックスバスに送られます。

● Mix Busは、プロジェクトの最終ミックス出力として使用します。物理出力に接続できるので、レイバッ
ク用のテープマシンやメーターなどに直接ルーティングすることができます。

Next をクリックしてください。

Channels Configuration Pageは、プロジェクトで使用す
るチャンネルStripの数とタイプを選択します。

Pyramixのミキサーは、Monoから 32.2 までの Strip タイ
プを作る事ができます。

必要なストリップの数とタイプを選択してください。

***NOTE*** ミキサーには、左から右に、上から下にリスト
が表示されます。ミキサーの Strip #1は、一番上の行で作
成された最初の Strip となります。

Next をクリックしてください。

I/O Routing Pageは自動的に物理 I/O をミキサーの
Strip と Busに接続しようとします。

ミキサーの基本的なコンフィギュレーションを練習しますの

で、このチェックを入れないでください。

次のセクションでは、物理 I/O をミキサーにマニュアルで
接続する方法を説明します。

Finish をクリックしてください。

DXDプロジェクトでのDSD録音に必要な追加設定

Projectが開いたら、次のパラメーターを正しく設定する必要があります。
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I/OのDSD設定

● インターフェースがDSDモードに設定されていることを確認し、DSDタイプ（DSD 64/128/256）を
Projectに合わせて選択してください。

RECORDの設定

● Settings > All Settings > Project > Record タブを開き、Formatが DSDファイル タイプ（
DSDIFF, DSF,WSD, MTFF）を選択していることを確認してください。

PLAYBACK/RECORDの設定

● Settings > All Settings > Application > Playback/Record タブを開き、Real-time Sample
Rate Conversionが Very High (Hepta - Apodizing)に設定されていることを確認してください。こ
の変更を適用するには、アプリケーションを再起動する必要があります。

MIXER DITHER SETTING

Pyramix DSDを使用するときは、Pyramix Mixerの Dither を常に OFFにしてください。Redbook CDイメー
ジファイルへの変換に必要なディザリング/ノイズシェーピングは、Generate CD Image / SACD Edited
Masterウィンドウで行います。
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RECORDING DSD
レコーディングワークフローの設定について話す前に、2つの異なる意見があると考えられることについて、再
び議論を持ち出す時です。どのようなフォーマットで納品し、どのようにそのゴールを達成するのかが分かってい

るときに、どのように録音するかという質問は、選択をする前に問うべき非常に重要なものです。

最も重要なことは「このプロジェクトの作業中に、ミキシングインザボックスを行うか？」ということです。

もしその答えが「イエス」なら、マルチトラックを DXDで録音することをお勧めします。単純な理由は、DSDで録
音した場合、ミキシングを行うためにDXDに変換し、最後にDSDに戻すためにまた変換しなければならないから
です。ですから、DXDで録音することで、変換の手間を省くことができます。

以下は、DSD そしてピュア DSD をマルチトラックソースとして使いたい人のためのものです。

ワークフローは

● Pyramixをマルチトラックレコーダー/エディターとして使用しながら、アナログコンソールでミキシングす
る。

● DSDリリースとして再発売するために古いアナログマスターを録音する。
● ライブ コンサートのDSDリリースのためにアナログコンソールの出力を録音する。
● その他
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RECORD SETTINGS

ここで考慮すべき最も重要なことは、最終的に何を出力す

るかということです。Render Mode でSACDを制作する
場合、DSDプロジェクトではDSDIFF, DSF, MTFFが使
用できますが、DXDプロジェクトでは DSDIFF しか使用
できません。

DSDファイルの種類

Pyramixには DSD素材を扱える様々なファイルタイプに
対応しており、目的に応じて録音フォーマットとして使用す

ると便利です。これらのフォーマットの詳細と、それを選択

する理由について、以下をお読みください。

DSDIFF

Phillips社が開発した Direct Stream Digital
Interchange File Formatは、DSDで作業する際に選択
可能な3つのフォーマットのうち、「プロフェッショナル」な
フォーマットです。

DSDIFFは制作に必要なあらゆる情報を含むことができ
ますが、DSFは 「民生用」のファイル タグ付けを可能にす
る出力形式として意図されています。また、ミキシングではなくレンダリングされるSACD作品に取り組む際に
は、録音用フォーマットとして使用することが絶対条件となります。

SDM SETTINGS
DSDIFFで録音する場合、Sigma Delta Modulation（SDM）のタイプを選択できます。
SDM B
最も古い SDM タイプです。CPUリソースへの負荷も最も低いので、録音中にストールが発生する場合は、こち
らを試してみてください。ただし、他の2つのタイプには劣り、SDM Dや Eほど大音量では動作しません。

SDM D
シグマデルタ変調の中で最もよく使われるタイプです。SDM Dは大音量が得意で、最近のコンピュータはトラッ
ク数が増えてもほとんど問題なく使用できます。SDM Dは Pyramix DSDIFF ファイルフォーマットのデフォルト
のモジュレータです。

SDM E (Trellis E)
これはリアルタイム操作（録音）で使用するものではありません。SDMタイプの中では最も透明度が高いので、
オフ ラインでモジュレーションが必要な作業（レンダリングやオフライン ミックスダウンなど）を行う場合は、このタ

イプを選んで使用するとよいでしょう。ただし、処理に時間がかかるので注意してください。
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MTFF

MTFF (Merging Technologies File Format)は、私たちのチームによって開発された包括的なファイルフォー
マットです。MTFFは、あらゆるサンプルレート、あらゆる解像度のPCMまたはDSD情報のコンテナとして設計さ
れています。また、メタデータを含めることもできます。

DSD制作で使用する場合は、DSD128 または 256 を録音する際に使用するデフォルトのファイルフォーマット
です。プロプライエタリ フォーマットなので、最終的に納品するためのものではありません。

DSF

DSF (dsd stream file)は、2008年頃にソニーが発表したフォーマットで、コンシューマー向けの DSDメディア
フォーマットがなかったことに対応するためのものです。録音したファイルをソフトウェアDSDプレーヤーに配信
したい場合に使用するとよいフォーマットです。

DSFの LSBとMSBの設定
これらはデータストリームのビットオーダーを決定します。LSB（リトルエンディアン）をお勧めします。これは
Intel系のCPU（MacやPC）で使用されているビット順です。しかし、何らかの理由でMSB(ビッグエンディアン)を
使用していることを知っているプレーヤー用にファイルを作成する場合は、私たちが推奨する(LSB)からMSBに
変更することを、ここで情報に基づいて決定することができます。どちらの場合でもサウンドに影響はありませ

ん。

WSD

ソニーの DSFに似ていますが、コルグが開発したものです。DSD64 と DSD128のレートでのみ動作します。
また、id3タグを使用せず、代わりに基本的なトラック情報のためのシンプルなASCII（英語テキスト）入力フィー
ルドがあります。WSDはMSB（ビッグエンディアン）ビットオーダーを排他的に使用します。

ファイルの種類と選択する場合の概要

DSDIFF ミキシング（レンダリング）なしで直接SACDを作る場合に使用する。SACDリリースのために
古いアナログ・マスターをキャプチャーする場合、最適で「最もクリーン」な選択です。

MTFF DSDレート（64/128/256）に関わらず、一般的なDSD制作に使用できます。録音したコンテン
ツをポストプロデュースしたり、マスタリングプロセスでミキシングモードを使用する場合は、こ

のファイルフォーマットをデフォルトで使用するのがよいでしょう。

DSF/WSD 録音したコンテンツを、関連するタイプのプレーヤーを持っている人が直接（他のプロセスを経

ずに）使用する場合、またはアーカイブする目的で使用します。これらのファイル形式は、最終

的な配信ファイル（編集後など）としては、レコーディング形式よりもはるかに便利な選択です。

DSDプロジェクトにトラックを追加する
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「純粋なDSDプロジェクトの設定」のセクションで述べたように、今のところアクティブなプロジェクト内ではできま
せん。一度トラック数を決めると、そのトラック数に縛られます。希望するトラック数で新しいプロジェクトを始める

必要があります。

DXD PROJECT では、少し簡単になります

DXD プロジェクトは通常の PCM プロジェクトと同様に動作するため、トラックを追加する際の柔軟性が大幅に
高まります。 トラックメニューの “Add Audio Track” を使用して、トラックとストリップの追加を行うことができま
す。

TIMELINE RESOLUTION

これは少し奇妙に思えるかもしれませんが、非常に重要なポイントです。DSD を使用する場合、DSDの「フ
レーム」は CD フレームに基づいています。 したがって、これらのフレームの端の外側で操作を行うと、奇妙な
アーティファクト（カチッという音）が発生する可能性があります。 これらのフレームのエッジに基づいて、再生を

開始し、録音を開始および停止し、編集する必要があります。 したがって、次の設定は非常に重要です。

● Edit > Snapは Snap to Scaleに設定してください。
● Edit > Snapは Snap Cuesorに設定してください。
● Edit > Snapは Snap Selection Headに設定してください。
● View > Timecode Resolutionは CD Framesに設定してください。

NUDGE SETTINGS

NUDGEの設定もフレームの境界にロックするように設定しましょう。

● All Settings > Application > Editing を開きます。
● Nudge Preset 1 を 1 CD Frameに設定します。
● Nudge Preset 2 を 10 CD Frameに設定します。
● Nudge Preset 3 を 75 CD Frame （1秒）に設定します。
● Nudge Preset 4 を 750 CD Frame （10秒）に設定します。

これですべての作業がフレームに適合し、作品に不要なノイズが入らないことが保証されます！
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DXD PROJECT で DSD を録音する

このハイブリッド ワークフローでは、すべてが正しく録音され、思い通りに再生されることを確認するために、いく

つかの追加設定を行う必要があります。

RECORD SETTINGS

前のセクションと同じです。

SAMPLE RATE CONVERSION (SRC)の設定
Pyramixは、録音されたDSDファイルをリアルタイムでSRCし、ミキサーから再生します。そのため、タイムライ
ンSRCをオンにしておくことが不可欠です。

信号の流れ：

入力 -> A/D -> DSDストリームをPyramixへ -> DSDとしてドライブに記録 -> SRCをDXDへ -> ミキサーへ ->
出力バス

SRCを正しく設定する：
● All Settings > Application > Playback/Record を開きます。
● Real-time Sampling Rate Conversion セクションで DSD & Mastering HEPTA SRC を選択し

ます。

● Pyramix アプリケーションを再起動します（これでアプリケーションに設定されるので、毎回設定する心
配はありません）。

すべての設定が完了したら、DXDプロジェクトでDSDレコーディングを行う準備が整います。
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EDITING DSD
純粋な DXD制作で作業する場合、制約はありません。しかしDSDでは、フォーマットを最大限に活用するため
に、作業を始める前に知っておかなければならないことがあります。DSDファイルに何らかのゲイン変更（フェー
ド、クリップゲインなど）を伴う編集を加えると、そのクリップは（バックグラウンドで）常にDXDに変換され、出力で
再変調されます。編集する必要がない場合は、純粋なDSDのままにしておくセクションで再変調の過度の使用
を避けるために、編集しない方がよいということは知っておく価値があります。

DSDでのカット、スプライス、ゲイン変更、フェードの作成
DSDプロジェクトでは何でもそうですが、CDの各フレームを正しく維持するために、慎重にカットを行うことが不
可欠です。フレームとフレームの間でカットやスプライスを行うと、その時点でクリックやポップが発生しやすくな

ります。

常にCDフレームの境界でカットしていることを確認する方法：
● Snapの設定が正しく設定されていることを確認してください（これについては、「TIME RESOLUTION

」の章を参照してください）。

● 常にカーソルを CD Frameに Snap した状態で作業してください。
○ 以下の場合、Snap機能はカーソルに適用されません。

■ Play を Stopすると、CD Frameの外側で停止することがあります。
■ Tabキーを使用して、CD Frameにない編集ポイントに移動する。

● NOTE: カーソルをルーラーバーでクリックすると、最も近い CD Frameに Snap します。

● 常にタイムラインカーソルを使ってカットしてください（カットツールの修飾キーは使わないでください）。

● 手動でメディアをスリップさせないように最善を尽くしましょう。代わりに Nudgeコントロールと様々な
Nudge Preset を使ってください。

● メディアを手動でスリップさせる場合は、スナップ設定が適用されていることを常に確認してください。

● メディアを手動でスリップさせたら、もう一方の端も境界線上で終わっていることを常に確認してくださ

い。

● 手動でドラッグする代わりにフェード／クロスフェードを作る場合

○ クリップのフェードしたい位置にカーソルを置きます。

○ クリップを選択します。

○ "[" または "]" を使って選択範囲の開始または終了をカーソル位置に設定します。
○ 右クリックし、フェードを適用する範囲を選択します。

■ Fade In＞ Fade In New
■ Fade Out > Fade Out New
■ X Fade > X Fade New
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クリップゲイン

タイムライン上の DSDメディアに クリップゲインの変更を適用することもできます。ただし、タイムライン上で行
う他のレベル変更と同様に、これは DXD としてタイムライン外で再生され、フェードなどと同様に再変調される
ことを覚えておいてください。

タイムライン上でメディアをスリップさせ、メディア間のサウンドを揃える

クリック音やポップ音が発生しないように各クリップの端を CD Frameの境界に揃える必要がある一方、つなぎ
合わされるメディアの位置を揃えるために、クリップ自体の中でメディアを滑らせたり動かしたりするのはまったく

問題ありません。 タイムライン上でメディアをスリップさせる (SHIFT+CTRL を押しながらメディアを移動する)
と、問題なく機能します。

注意すべき点がいくつかあります：

● メディアをスリップさせるためにフェードエディタを使用し、Fade Safe と Fource Safe を有効にしてい
る場合、タイムラインのさらに下のフレーム境界に問題が生じる可能性があります。これらの機能は、タ

イムラインのさらに下の編集も確実にスリップさせるため、フレーム境界から外れてしまい、問題を引き

起こす可能性があります。

○ この場合、これらの機能が両方とも無効になっていることを確認することをお勧めします。

○ スリップを使用する代わりに、CD Frameの精度を確保するために以下を使用してみてくださ
い：

■ 編集するエリアを Mark In と Mark Out を設定します。
● タイムライン上でエリアを選択し、ENTERを押して Mark を表示させます。
● 2秒間の Pre-Roll を編集に入れる。
● トランスポートで Loop をオンに設定する。

■ 別のクリップと揃えたいタイムライン上のクリップを選択します。

■ Clip > Select > Add All Following Clips to Selection を使います。
■ 次に Nudge Clipキーで選択範囲全体を移動します。

DSDファイルへのエフェクトのレンダリング

Pyramixの Render を使って、DSDタイムラインのファイルにエフェクトをかけることができますが、DSD64の
みが対象です。このプロセスでは DXDに変換する必要があることに注意する必要があります。これは必ずしも
悪いことではありませんが、DSDピュアリストにとっては受け入れられないかもしれませんので、議論する必要
ががあります。

DSD Projectでは、Formatは DSDIFF でなければなりません。つまり、最終的に2回の変換を行うことになり
ます。1つは DXDに変換してファイルを処理し、もう1つは DSD64に戻す変換です。

DXD Project では、Formatはむしろ MTFFにすべきです。最終的に2つの変換を行うことになります。1つは
ファイルを処理するために DXDに変換し、次にミキサー出力で DSD64に2度目の変換を行います。DXD
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Project で DSDIFF を選択した場合、ファイルを処理するためにDXDに1回、タイムライン上のファイル用に
DSD64に1回、ミキサー出力でもう1回、合計3回の変換を行うことになります。

レンダリングに使用されるPCMサンプルレートについての注意事項

● DSD128 で作業する場合、実効PCMサンプルレートは DXD x2 (705.6 kHz)となります。
● DSD256 で作業する場合、実効PCMレートは 1.4112MHzになります。

DSD RENDERER を使ったレンダリング

このツールは、タイムライン上の他のファイルの一部から新しい DSD ファイルを生成するために特別に作成さ
れました。 この新しいファイルの作成は、最初に DXDにアクセスする必要がなく、タイムライン上の選択された
領域の重複した数字の正確な数字を維持します。 このツールは、Project > DSD Renderにあります。 ただ
し、これはデジットからデジットへのコピーですので、DSDバリアント間の変換は行われないことに注意してくだ
さい：タイムライン上に DSD128 ファイルがある場合は、新しい DSD128 ファイルがレンダリングされます。他
の DSD ファイルバリアントに変換したい場合は、後述の 「Album Publishing機能を使用してさまざまな
DSD マスターを作成する」セクションを参照する必要があります。

DSD Render ツールは、クリップの Gain, Fade, Phase を処理します。 Envelopeは処理されません。
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MIXING DSD
DSD を DXD でミキシングする

DSDレコーディングをボックス内でミックスしたい場合は、特別なモードでプロジェクトを開く必要があります。公
平を期すため、この時点ですでにDSD編集プロジェクトを開いたり閉じたりしている場合は、開くたびにプロジェ
クトをDXDミキシングプロジェクトに変換するかどうかを尋ねるポップアップが表示されます（Pyramixの
Settings > Application > General で Ask DXD/DSD Conversionオプションが有効になっている場合）。
これはまさに、DSD素材をミックスするときにやりたいことです。

これは本質的に、DSDを録音するように設定された DXD project と同じように動作するプロジェクトを作成する
ことです。ですから、DSD素材をミックスすることが決まっているのであれば、DSDを録音する DXD projectの
セットアップガイドを使って始めることができます。

いずれにせよ、DSD project を Mixing Mode で開けば、標準的なPCMプロジェクトと同じようにミキシングでき
ます。

レコーディングに使用した既存の DXD project で DSDをミキシングする

DXD projectに DSD を録音して作業を開始した場合、すでに上記の DSD Mixing Modeの設定になっていま
す！

この Mode で注意すべきこと：

● All Settings > Application > Playback/Record で Real-time SRC を有効にし、DSD &
Mastering Hepta SRCに設定する必要があります。

● Pyramix DSDを使用するときは、Pyramixミキサーの「Dither」機能は常に Offのままにしておいてく
ださい。Redbook CD Image ファイルへの変換に必要なディザリングとノイズシェーピングは、
Generate CD Image / SACD Edited Masterウィンドウで行います。

dsp Japan Ltd, 4-8-5 Nakameguro, Meguro-ku, Tokyo 153-0061

T : 03-5723-8181 F : 03-3794-5283 U : http://www.dspj.co.jp

26



MASTERING DSD
レコーディングが終わり、それを編集し、最終的にマスタリングするバージョンまでミックスしたら、最終的にどうし

たいか、どう作りたいかによって、さらに考慮すべきことがあります。

DSD RENDER を使った DSD レンダリング

これはレコーディングの DSDマスターを生成する最もシンプルで透明性の高い方法です。タイムラインの内容
を（ミキサーを通さずに）ビット単位でコピーし、そこから DSDIFF ファイルを作成するだけです。このプロセスは
DSDレートを変更せず、常にDSDIFFファイルを生成します。

このプロセスで注意すべき点

● タイムライン上のすべての DSDファイルは、信号に再変調を加えることなく、ビット単位でコピーされま
す。

● タイムラインで行われたすべての Fade, X Fade, その他のゲインの変更は、DXDでレンダーで再生さ
れ、タイムライン上の DSDファイルのレートで DSDに再変調されます。

● DSDIFFは、タイムラインの内容に関わらず、常にレンダラーの出力となります。

DSD CONVERTING

異なるDSDファイルを提供する必要がある場合、他のタイプのDSDファイルを作成することができる追加のソフ
トウェアがあります。DSD256ファイルからDSD64ファイルを作成するなどは、DSDCoverterツールで可能で
す。

このツールはスタートメニュー >すべてのプログラム > Merging Technologies > Pyramix > DSD
Converterにあります。

これにより、DSDフォーマットの変更だけでなく、WSDからDSFなどへの変更も可能になり、必要なフォーマット
に関わらず、クライアントへのファイル提供がより簡単になります。

dsp Japan Ltd, 4-8-5 Nakameguro, Meguro-ku, Tokyo 153-0061

T : 03-5723-8181 F : 03-3794-5283 U : http://www.dspj.co.jp

27



ファイルタイプの選択に関する注意

一部のファイル タイプには遵守する必要がある制限があるため、変換するファイル タイプを決定する際には注

意が必要です。

DSF：1～6 チャンネルをサポートします。

WSD：DSD128 までサポート。

MTFF：マスター作成用の Channel typing metadata で最大6チャンネルをサポート（最終的なフォーマットで
はありません）
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SACD MASTERING P25
スーパーオーディオCDには、DSD情報のみを含む「シングルレイヤー」と、DSDとRedbook CDオーディオの
両方を含む「ハイブリッド」の 2つのフォーマットがあります。後者は基本的に、レッドブックCDをシングルレイ
ヤーのSACDに接着したものです。各レイヤーに異なる波長のレーザー光を巧みに（そして必然的に）使用する
ことで、物理ディスクの片面のみから両方のレイヤーを読み取ることができます。SACDのレイヤーは、さらに2
つの「エリア」に分かれています。1つは 2チャンネルDSD用で、もう1つはマルチチャンネルDSD用です。

マルチチャンネルオーディオの場合、最大チャンネル数は 6.0（全チャンネルがフル周波数特性）です。その他
の一般的なマルチチャンネルタイプには、5.0、5.1、4.0、3.0があり、2.1や 2.0 もあります（マルチチャンネル
エリアに別のステレオプログラムを置くこともできます）。

マルチチャンネル領域に置くファイルは、2, 5, 6 チャンネルのコンテナでなければなりません。もし「3.0」マルチ
チャンネルファイル（L,C,R）を作り、SACD-Renderメソッドを使いたい場合は、未使用のサラウンド チャンネル
のペアが通常あったであろう時間軸に、非常に短い「ダミー」ファイルを配置する必要があります。Pyramix
DXD Mixing Mode では、ミキシングバスの選択によって正しいチャンネル数が作成されるため、このような作
業を行う必要はありません。

SACDマスタリングプロセスには 3つの明確なステップがあります：

1) トラックマーカーやその他のメタデータが埋め込まれた、必要なエリアごとに連続したDSDIFFファイル
を作成する（いわゆる "Edited Master"ファイル）

2) 必要な場合、"Edited Master" ファイルのサイズを縮小するために、"Direct Stream Transfer（DST）"
ロスレスデータ圧縮アルゴリズムを利用し、ディスクの再生時間を効果的に増加させます。ステレオの

みのSACDであれば、DST圧縮を適用する必要はありませんが、再生機へのファイル転送がスピード
アップすることは間違いありません。

3) オーサリング： 製造前の、誤解されやすく華やかさに欠ける最終段階。この段階では、DSDIFF編集マ
スター（または同じものをDST圧縮したもの）は、SACD-テキストと一緒に1つのファイルに多重化さ
れ、いくつかの小さな複製専用のコントロールファイルとともに、SACDイメージファイルと呼ばれるもの
になります。このイメージファイルは、ソニーの "カッティングマスターコンバーター" アプリケーションを
使って、"ユニファイド カッティングマスターフォーマット" ファイルセットに変換されます。このアプリ
ケーションからの出力ファイルは、電子的に送信するか、DVD-Rに焼かれて物理的なディスクとしてレ
プリケーターに送られます。

4) 製造については、このガイドの範囲外のトピックとさせていただきます。
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CDアルバムのテキストとトラックマーカー

SACDマーカーを配置し、すべてのテキスト情報を手動で入力するか、Pyramixと互換性のあるファイルをイン
ポートする必要があります。これらのSACDテキストファイルには、SACDをプレーヤーに入れたときに表示され
る、すべてのトラックタイトル、アーティスト、その他すべてのグッズに関連するテキスト情報が含まれています。

ハイブリッド SACD（DSDとRedbook CDオーディオ）を制作する場合、Pyramixの仕組み上、CD-Markersを
先に作成し、そこからSACDテキストとマーカーを作成する方がはるかに優れています。SACD-Textは
CD-Text よりもはるかに "リッチ"で、特に多言語サポートに関しては、CDでは事実上存在しません。これは、2
つのレイヤー間でテキストを一致させることが重要な場合に問題になることがあります。また、CD/SACDタブの
ディスクアイコンを右クリックし、Copy Disc Info を選択すると、データを別のディスクに貼り付けることができま
すが、SACDとCDの間で一致しないフィールドがあるため、足りないフィールドを手動で入力する必要がありま
す。

これらのファイルには 2つのフォーマットがあり、Pyramixはどちらもサポートしています：
● Philipsの SUPERAUTHOR または SUPERAUTHOR TOC EDITORrソフトウェア（.lbmフォーマッ

ト）

● ソニーの SACD TEXT EDITOR ソフトウェア（.mtsフォーマット）

CD/SACD タブの SACD専用コントロール

MULTICHANNEL領域と STEREO領域

マルチチャンネルDSD編集とステレオDSD編集をタイム
ライン上で一直線上に作成すれば、一方のトラックのス

タート、ストップ、インデックスマーカーを設定し、他方にコ

ピーすることができます。これにより、ステレオバージョン

がマルチチャンネルバージョンとまったく同じように動作

するSACDを提供することができます。
エリア上で右クリックし、Copy Stereo/Multichannel area
to Stereo/Multichannel area を選択します。

SACD エリアの設定

ステレオレイヤーとマルチチャンネルレイヤーの両方で、エリア タイプを設定して、Render Modeにタイムライ
ンのレンダリング方法を知らせる必要があります。 この設定は Tree Info タブにあります。

1つを除いて、すべてのエリア タイプは完全に意味をなすはずです。 Stereo + Exxtra Dataは現在実装され
ていないため使用できません。

SACD タブのその他の設定と入力エリアはすべて、標準的な制作用のものであり、ラベルのアーティスト情報が
最終的な SACD情報の一部となるように配置されます。
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SACD TEXT

SACD Textは、SACDを制作する国や、実際に追加したいテキスト情報の種類によって、いくつかの設定があ
ります。

SACDのエリアを作成したら、まず最初にテキストタイプの情報を設定します。

1. 左側のナビゲーションエリアから SACDディス
クを選択します。

2. ディスクにジャンルを設定する場合は、Genre
テーブルを「General Genre」（必要であれば
「Japanese Genre」）に設定し、下のジャン
ルを選択します。

SACDディスクにジャンルを設定したくない場
合は、Genre テーブルを「TABLE NOT
USED」にしてください。

3. Disc Area を1つ選択してください
4. 最初のSACDエリアの Tree Info エリアに入

ります。

5. セクションを下までスクロールすると、Area
Textがあります。

6. 必要な言語の文字セットを設定します。

a. ASCII文字セットは英語にのみ適しています。
b. ISO 8859-1は、ラテン語、スカンジナビア語、東ヨーロッパの言語をカバーします。
c. ミュージック Shift-JISは日本語に適しています。
d. KSC-5601は韓国語に適しています。
e. GB2312は中国語に適しています。

7. 文字セットの下のフィールドで使用する言語を設定します。

キャラクタ セットはステレオとマルチチャンネルの両方の領域で一致していなければなりません。もし一致しな

い場合、カッティングマスターを作成する過程でSACDは失敗します。

CREATING THE DSD EDITED MASTER

DSD 'Edited Master'は、SACDのオーディオコンテンツを提供するために使用される、特定のタイプの
DSDIFFファイルです。すべてのオーディオは、2, 5, または 6チャンネルの 1つのマルチチャンネルファイルに
保存されます。ファイルヘッダには、'Scarlet Book準拠のSACDディスクイメージを作成するために使用され
る、以下のようなデータが含まれています：

● ラウド スピーカー構成（Stereo, Surround 5.0, Surround 5.1）
● マーカー（Start, Stop, Index）
● Edit Master ID
● アーティスト名
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● ディスクタイトル

SACDのプリマスタリングプロセスのゴールは、以下の2つの方法のいずれかでこの Eduted Master を作成
することです：

RENDER MODE を使う

タイムライン上に存在するメディアを単純にレンダリングし（DSD Rendererツールがそうであるように）、出力に
SACDディスク情報を追加する作業を行うだけなので、SACDを生成するための「最も純粋な」ものです。最終
的なマスターのトラック順を反映するように、メディアが正しいトラック順に配置されていることに依存します。

Render Mode での SACD Edited Master作成は、使用されるメディアの数を自動検出し、それに応じてメタ
データを作成します。

マルチチャンネルファイルが 5ch または 6ch であると SACD Render Mode を "騙す "ために、先に述べた
"dummy" ファイルが便利です。

SACD TRACK LAYOUTS FOR THE TIMELINE:

5.1SURROUND 5.0 SURROUND 2.0 STEREO

1. Left
2. Right
3. Centre
4. Lfe
5. Left Surround
6. Right Surround

1. Left
2. Right
3. Centre
4. Left Surround
5. Right Surround

1. Left
2. Right

注意

異なるスピーカーコンフィギュレーション（4.0 "Quad" ミックスや LCR 3.0ミックスなど）を作成する必要がある
場合、音の入っていないトラックに短いサイレントDSDIFFファイルを配置する必要があります。そのためには
Render機能を使います。

1. 空のトラックで、タイムラインの一部を少し選択します。

2. Project > Render を選択します。
3. Renderウィンドウで、None を選択します。
4. File Typeに DSDIFF を選択します。
5. 選択部分を新しいメディアとしてレンダリングします。

6. DSDIFFサイレンス ファイルを、最初の SACD Makerに、素材の開始時間に合わせて、空の状態で
配置します。

これにより、そのトラックは無音のトラックになります。レンダリングプロセスにより、アクティブチャンネルのオー

ディオと一緒に、無音トラックがファイル内に作成されます。

RENDER MODE でのワークフローに関する提案

1. サラウンド用のトラックグループとステレオ用のトラックグループを作成します。
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2. 両方のセクションを互いに一致するように編集します（両方とも位相が揃います）。

3. CD/SACDタブでサラウンドエリアを選択した状態で、SACDマーカーをタイムラインに追加します。
a. エリアタイプが正しく設定されていることを確認してください！

4. すべてのトラック情報を追加します。

5. 完了したらマーカーをコピーし、Stereoエリアに貼り付けます。
a. ツリー情報がステレオエリアタイプに設定されていることを確認してください！

6. Document Library を使い、各エリアを別々の Document Library Edit として保存します。
7. タイムラインから Stereo編集を削除し、Surround エリアをレンダリングします。
8. 終わったら、タイムラインから Surround エリアを削除し、Document Libraryに移動して、Stereo エリ

アをその場所に配置します。

a. タイムラインでトラック 1を選択します。
b. ステレオエリアを右クリックします。

c. Place at Original Timcode on Selected Track を選択します。
9. Stereo エリアをレンダリングします。

GENERATE THE EDITED MASTER IN RENDER MODE:
Master Settingsの Generate Master メニューで、DSD Edited Master (DSDIFF) を選択し、Sample Rate
を DSD64に設定し、DSD Rendering mode を選択します。ファイルの格納場所とフォルダの名前も設定して
ください。

Render mode では、ゲインの変更、フェード、位相反転が適用されますが、Envelopeの変更は適用されない
ことに注意してください。

Pyramix v12以降、”Process DSD at original Sapmle rate（元のサンプルレートで DSD を処理）”により、
元の DSD素材のサンプルレート (つまり、DSD64の場合は 64 Fs、DSD128の場合は 128 Fs、DSD256
の場合は 256 Fs) で DSD レンダリング処理 (ゲインとクロスフェード) を実行できます。
Stereo と Multichannel エリアの両方を計画している場合は、Post Processingのセクションで DST
encoding を有効にすることができます。その場合、DST エンコードされたファイルが必要になるためです。
DST エンコードは後で実行することもできます。SACD Masteringの章を参照してください。

MIXING MODE を使う

Miing Modeは、DXD プロジェクトで作業している場合、またはあらゆる種類の PCM を使用している場合に使
用します (44.1 kHz素材から SACD を作成することを推奨しているわけではありません)。
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このモードでは、すべての素材が（リアルタイムで）DXDに変換されてタイムラインからミキサーに信号が供給さ
れ、出力ステージで DSDに再変調されます。これは、プロジェクトを開始したときに選択したか (DXD プロジェ
クトでの DSDの操作に関するセクションを参照)、または Project > Open で Open in DXD Mixing Mode を
選択したのかもしれません。

これを行う場合、作成したい DSD マスターのチャンネルタイプ（5.1, 5.0, または Stereoステレオ）を反映する
Busが必要になります。その後、マスターの作成時にこの出力をマスターのソースとして選択するだけです。

Generate Master メニューで必要な領域を選択し、対応する出力Busにチェックを入れます。 マルチチャンネ
ルエリアの場合は、チャンネルマッピングが SACD チャンネルマッピングであることを確認してください
(SACD TRACK LAYOUTS FOR THE TIMELINE:を参照)。 Merging では、SACD トラック レイアウトと一
致する 5.0 または 5.1 SMPTE bus を使用することをお勧めします。各エリアの Edited Masterは、個別に作
成する必要があります。

次に、Master Settings で、Type を DSD Edited Master ‘DSDIFF)に、Sample Rate を DSD64 (SACD)に
設定します。 SACDに互換性があるのは DSD64のみであり、DSD128 と 256は互換性がありません。
Album Publishing では、より高い DSDサンプリングレートから DSD64編集マスターを生成することもできま
す。

保存場所と名前も設定してください。

Stereo と Multichannel エリアの両方を使用する予定がある場合は、Post Processing セクションで DST
Encoding を有効にすることができます。DST エンコードは後で実行することもできます。SACD Masteringの
章を参照してください。
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DSD Eduted Masterが作成されると、複製工場に送るために必要なものがほぼすべて揃ったことになり、工場
では SACD イメージを構築し、それを使用して最終的な物理 SACD を作成できるようになります。

Pyramix ソフトウェアにもう少しお金をかけてもよい場合は、PSO-SAAオプション (SACDディスクオーサリン
グオプション) を装備させると、工場に納品する最終ファイル UCM (ユニバーサルカッティングマスター) を出
力することもできます。 その後、それを複製プロセスに使用するだけです。
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SACD CUTTING MASTER を使う

Super Audio CD Authoring and Disc Builderオプションが入った Pyramix ではこのツールが使用できま
す。以下を読んでご興味があるようでしたらお近くの Merging Technologies販売店からオプション ライセンス
をご購入下さい。

SACD Cutting Masterは SACDディスク制作の最後のステップで使用します。

STEP TO TAKE

➔ ディスクイメージの名前をつけます。

Note:文字数には制限があり、無効な文字は自動的に変換されます。

➔ 中間イメージ フォルダーと最終イメージ フォルダーがあります。書き込み先は、少なくとも 20 GBの空
き領域が常にあることを確認してください。 これは、オーサリングプロセス中に多数の中間ファイルが

作成されるためです。

➔ Input Audio File セクションには、Stereo と/または Multichannelの Edited Master を与えてくださ
い。ファイルが DST エンコードされておらず、DST エンコードが必要な場合は、ここでエンコードを実
行できます。

➔ Generateボタンをクリックします。
Save asウィンドウで、.lbm ファイルの名前とパスを入力できます。
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SACD DISC BUILDER

マスタリングプロセスのこの時点では、次のものが完成しているはずです。

1. Multi-Channel DSD Edited Master
a. DST エンコード済み

2. Stereo DSD Edited Master（必要な場合）
a. DST エンコード済み

3. SACD textからエクスポートされた .lbm

SACD Builderは非常に簡単なツールです。 マスタリングプロセス中に生成したコンテンツを正しい領域に入
力するだけで、プロセスが実行されます。

NOTE
中間フォルダとイメージフォルダを選択した場合は、書き込み先に少なくとも 20GBの空き領域があることを確
認してください。 これは、オーサリングプロセス中に多くの中間ファイルが作成されるためです。
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AFTER THE CUTTING MASTER – MAKING THE UCMF FILE

Unified Cutting Master Formatは、弊社のウィザードで作成されたファイルを Sony Cutting Masterに変
換するものです。

このツールは Sonyによって開発されたものであり、Mergingがこのツールに機能を変更したり追加したりする
ことはできません。

当社Webサイトから Sony Cutting Master Converter をダウンロードし、任意の場所に解凍してください。
http://www.merging.com/uploads/assets/Installers/CMConv_ver1120.zip

手順：

➔ - CuttingMasterConverter.exe を開始します。
デフォルトでは、常にテープデバイスを検索しま

す。OK をクリックして警告メッセージを閉じま
す。

➔ Media1 または入力ファイル タイプとして Sony
CM を選択します

➔ DiscBuilder で生成されたイメージ (.DAT ファ
イル)が含まれるフォルダーを参照します。

➔ Media2 または入力ファイル タイプとして
SA-CD UCMF フォーマットを選択します

➔ Convert & Compare を選択します。
➔ Excute をクリックします。

警告やエラーが出る場合は、ログを参照してください。

残念ながら、ログの表示機能は最近のコンピュータでは動作しなくなりましたが、ログ ファイルを読むことはでき

ます。

CMConv ver1120 フォルダーを参照し、cmconv_log.xml を開いてください。
処理されたすべての UCMF変換のログを取得し、最新のものを参照します。
“warn” と “error”のエントリのみに注意してください。
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ハイブリッド SACDディスク用 Redbook CD レイヤーの作成

ハイブリッド SACD を作成する場合は、Redbook標準CD-R または DDP も別途用意する必要があります。 こ
れを DSD Edited Master（必要に応じてMultichannelとStereoの両方)から作成した Cutting Master と一緒
に工場に提供してください。

ハイブリッド SACD用の Red Bookオーディオを作成するにはさまざまな方法があり、選択する方法は DSD
マスターの作成方法によって異なります。CD マーカーとメタデータがすでに作成されていることを前提としてい
ます (オプション #4 を除く) 。

1. DSD プロジェクトから Edited Master を作成時に “SACD-RENDER” モードを使用する場合：
1.1. Project を DXD Mode で開きます (Pyramixの設定で ”Ask for DSD/DXD conversion”

オプションにチェックを入れておく)。
1.2. CD / SACD タブで、SACD領域から PQ Marker を選択し、右クリックのコンテキスト メ

ニューから ”Copy Markers” を選択します。PQ Makerを CD Disc セクションに貼ります。
1.3. Project メニューから “Generate CD / SACD” を選択し、Typeに ”Redbook CD Image”

を選択します。

1.4. 適切な出力Bus、ディザリング、および SRC アルゴリズムを選択します。

2. DXD Mixdown を使って Edit Master を作成する場合：
2.1. CD / SACD タブで、SACD領域から PQ Marker を選択し、右クリックのコンテキスト メ

ニューから ”Copy Markers” を選択します。PQ Makerを CD Disc セクションに貼ります。
2.2. Project メニューから “Generate CD / SACD” を選択し、Typeに ”Redbook CD Image”

を選択します。

2.3. 適切な出力Bus、ディザリング、および SRC アルゴリズムを選択します。

3. PCM プロジェクトを使用して Edit Masterを作成する場合：
3.1. Project メニューから “Generate CD / SACD” を選択し、Typeに ”Redbook CD Image”

を選択します。

3.2. 適切な出力Bus、ディザリング、および SRC アルゴリズムを選択します。

4. Red Book を別の場所で作成した場合：
4.1. Red Bookオーディオの CD-R または DDPが Unified Cut-ting Master Format ファイル

セットに含まれていることを確認してください。

CHECKING YOUR WORK

工場に納品しようとしているものが実際に機能することを確認することは、非常に重要なステップです。 UCMF
フォーマットのマスターを作成する前に、SACD Cutting Master を Pyramixにインポートして、すべてが計画ど
おりに動作 (およびサウンド)することを確認できます。
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SACD カッティングマスターのインポート

1. Project > Import を開きます。
2. リストから SACD Cutting Master を選択し、新しいプロジェクトを作成する（New Project）か、既存

のプロジェクトで比較したい場合は追加するか（Append）を選択します。
3. Cutting Master ファイル (.DAT) を見つけてインポートします。
4. ファイルがタイムラインに戻ったら、出力にルーティングして聞くことができます。

UCMF マスターを確認するには、いくつかの再生アプリケーションを使用して、UCMF '.DAT' ファイルの名前を
“ファイル名.DAT.ISO”に変更して開くこともできます。その後、テキストとオーディオの両方を確認できます
(DSD対応DAC をお持ちの場合)。 動作することが確認されているアプリケーションは、JRiver Media Center
(Windows)、AIMP (Windows)、USBAudioPlayer Pro (An-droid)、および Audirvana (Mac) です。
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SACD MASTERING APPENDIX

.LBM (または .MTS ファイル)
これらは、SACD制作で使用するために生成される TOCファイルです。 このファイルは、プロセスの一部として
カッティングマスターウィザードによって自動的に生成されますが、手動でエクスポート (またはインポート)する
こともできます。

Note
SACDオーサリングオプションがない場合、エクスポートされた TOCには各インデックスの TCリファレンスが
ありません。

Generate SACD Cutting Master を使用しない場合でも、.LBM または .MTS ファイルをエクスポートして、
SACD テキスト情報として使用できます。

.LBM または .MTS ファイルを手動でエクスポートする手順:

➔ CD/SACDタブに移動します。
➔ SACD Text メニューで Export を開きます。
➔ ファイルの種類 (.lbm または .mts) を選択し、ファイルを置く場所を選択します。

ANNEX D3 VERIFICATION
Annex D3 チェックは、SACD Scarlet ブックの Annex D3
仕様に準拠していることを確認します。 これにより、動作す

る許容最大レベルが 0dBSACDになることが決まります。
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ANNEX D4に障害が発生した場合の対処方法 – DSD マスターの HFノイズが多すぎる場合

Annex D3の検証が失敗した場合は、SACD Scarlet bookで許容されるよりも多くの HFノイズがあることを意
味します。 したがって、この HFノイズを軽減するために何かを行う必要があります。

HFノイズを除去するには、DXD mixing mode で Project を開き、出力Busに EQX プラグインを追加してくださ
い。次に、LPF (ローパスフィルター) を使用して 40～ 50 kHz付近/それ以上の周波数を除去し、量を非常に
緩やかに設定します。これは、より高い周波数で機能するため、より顕著なカットができます。

結果として生じる出力バスのノイズの量を確認するには、Mixerのメーターリングのフィルターを変更する必要
があります。 40～ 100kHzに設定された VS3 VU プラグインを追加するか、Settings > All Settings > Mixer
> Level Meter を開き、DSD Peal Filter を 40～ 100kHzに切り替えて測定します。

これを設定したら、DXDストリームから DSDに再変調する “Mixing Mode” を使用してマスタリングしてくださ
い。ワークフロー全体で純粋な DSDを維持していませんので、明らかに理想的ではありません。 しかし、SACD
の作成がまったくできないよりも、Re-Modulate した方が良いことになります。

DST ESTIMATION & ENCODING

DSTエンコーディングは、非常に多くのメディアを 1枚の光ディスク上に存在できるようにするアルゴリズムで
す。DSTエンコードは、サウンドをまったく変えることなく、DSD Edit Masterのサイズを縮小するエンコード プロ
セスです。

必要に応じて、最初のステップとして DST estimator tool を使用して、DSD Edit Masterをエンコードした後に
どのくらいのスペースが残るかを把握できます。これには数分かかり、最終的なエンコードされたサイズがかな

り正確に表示されます。 これは Media Managerの中で右クリックすると見つけることができます。

Estimator と Encoderは両方とも Media Managerにあります。アクセスするには Media Managerの中で
DSD Edit Master ファイルを選択し、右クリックのコンテキストメニューの中に項目を見つけることができます。
SACD Cutting Master Wizardはこれを自動的に行うため、このコンテキストメニューは最終ファイルのサイズ
を見積もるためだけに使用し、Cutting Master Wizardにエンコードさせることをお勧めします。

エンコードする戦略の選択

DST エンコードの際に選択できる “strategies”がいくつかあります。それらは、エンコーダーの動作方法と、エ
ンコーダーが達成する圧縮量に関連しています。
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SAME FOR ALL CHANNELS (00 / 000000)
“Same for all channels”は、チャンネル間の相関関係が良好な素材（同じ音楽であり、一般にほぼ同じように
聞こえる）に使用する必要があります。 いつでも安全な選択肢として 00が選択できます。

DIFFERENT FOR EVERY CHANNEL (01 / 01234 / 012345)
この strategiesは、ステレオ (01)、5 チャンネル (01234)、または 6 チャンネル (012345) マスター内のトラッ
ク間に相関がほとんどまたはまったくない場合に使用されます。

SAME FOR STEREO PAIRS (00122 / 001233)
この strategiesは、5 チャンネル (5.0) または 6 チャンネル (5.1) DSD Edit Master で使用されます。左と右
(00) センター単独 (1)、Lfe単独 (2) と左サラウンドと右サラウンド (5 チャンネルで 22 または 6 チャンネルで
33)間の相関を推定します。

DST estimator を使用し、DSD Edit Masterを試してみると、実際のエンコード時にどれが最も成功するかがわ
かります。
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DSD DIGITAL ALBUM PUBLISHING
SACD と物理メディアは現代では衰退しつつあります。ますます大きなファイルを非常に高速にダウンロードで
きるようになったことで、全てのジャンルでハイレゾルーションの音楽をダウンロードしたいという欲求が爆発的

に高まりました。 そして、DSD/DXDコミュニティもこのバンドワゴンに参加しています。

Pyramixは、さまざまな形式で DSD Digital Download ファイルのホスト全体を作成できます。

HOW THE PROCESS WORKS

すべての生成プロセスは常に、上のセクションで行った選択から始まります。DSD で Download ファイルを生
成したいだけの場合でも、CD/SACDタブで SACD を作成し、すべての情報を入力する必要があります。これ
は、album publishing toolがそのすべての情報を使用して、作成されるデジタルダウンロード ファイルのメタ
データを設定するためです。

1. Project > Generate Master を選びます。
2. Master Settings で、DSD Digital Release (MTFF) を選び、マスターファイルのサンプリングレート

とモードを選択します。

3. album publishing を Enableにして、Settings をクリックします。
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欲しいものを得るために album publishing設定を行う

この設定では、任意の数のファイル「セット」を決定でき、それぞれ

を独自のフォルダーに配置し、SACD TOC内のすべてのメタデー
タを使用して名前を付けることができます。

➔ Add をクリックしてファイルの種類を追加します。
➔ 上部のドロップダウンからファイルの種類を選択します。

➔ それぞれのサンプルレートとビット長を選択します。

➔ ダウンコンバートする場合はディザーを選択します。

➔ アルバム全体を単一のファイルにするか、トラックごとに個

別のファイルを分割するかを選択します。

ウィンドウの下部にあるセクションのメタデータ情報を編集すること

で、ファイルの名前の付け方を慎重に編集することもできます。 また、作成する各ファイル タイプのファイルの場

所もここで設定する必要がありますので注意してください。

これが完了すると、ファイル生成プロセスを開始できます。最後には、デジタルダウンロード ストアに送信でき

る多数のファイルが完成します。

ファイルタイプ選択の注意

DSD コンバーターのセクションでも述べたように、変換先のファイル タイプを決定する際には、遵守する必要が
ある制限事項があるため、特別な注意が必要です。

DSF：1～ 6 チャンネルをサポートします。

WSD：DSD128までのみサポート

MTFF：Channel type メタデータを使用して、最大 6チャネルをサポートします。 MTFFは独自の形式であるた
め、現時点では最終的な配信用ではありません。

DSDIFF Edit Master：DSD64 を使用して SACD Cutting Master を生成することができます。圧縮設定によ
り、プレーン DSDデータまたは DST エンコード ファイル（SACD Cutting Masterに Stereo と Multichannel
の両方の領域が存在する場合に必要）を作成できます。これらの DSD フォーマットの場合は、シグマデルタモ
ジュレーターを選択できます。Meco SDM（Pyramix v12以降、出力フォーマットの SDM セクションで利用可
能）は、DSD フォーマットから別のフォーマット (例：DSD256から DSD128)にパブリッシュする際に、高サンプ
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ルレート（64および 128 Fs）の中間マルチビット ステージを可能にします。 SDM Dおよび Trellis Eは、DSD
形式から別の形式にパブリッシュするときに、高度な PCM変換（DXD X1 / X2 / X4）を実行します。

CHECKING YOUR WORK

Digital Album Publishingワークフローでは、すべてのファイルをタイムライン上に簡単に置けるため、チェック
が簡単に行えます。すべてのファイルを Media Manager上に表示させ、Pyramix タイムライン内でリスニング
テストを実行できます。

Master MTFF、Edited Master、Cutting Masterのファイルは、Project > Import メニューでインポートするこ
とができます。

生成したファイルは、ネイティブのサンプルレートで再生すべきだということを忘れないでください。そうしないと、

SRC も聞くことになります。

上で述べたように、別のオーディオファイルアプリケーションを使用して、ファイルをチェックすることも可能です。
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STANDARD CD MASTERING OF DSD P38
CDはまだ入手可能であり、SACD情報を標準の Red-Book CD レイアウトに変換したい場合があります。最
初のステップは、CD/SACD タブで CD Disc を作成することです。

CD テキスト情報を SACD エリアから CD エリアに取得する

CDマスターまたは DDPイメージの生成に使用す
るために、SACDから CDウィンドウに情報をコ
ピーできる簡単な機能があります。

CD/SACDタブの Disc > Create CD Disc from
SACD Disc で、左のウィンドウが表示されます。

この情報にアクセスできたら、通常のCDマスタリン
グワークフローに沿って作業ができます。 16 ビッ
トの Red Bookイメージには、ディザリングを適用
する必要があることに注意してください。

CONCLUSION
これで、目的を問わず DSDプロジェクトを完了するために知っておく必要があるすべてのことをほぼ網羅しまし
た。もちろん、何か足りない点を見つけた場合、または教えてほしいと思われる場合は、いつでも

www.merging.com までお気軽にお問い合わせください。

The Merging Team

Contributors:
Graemme Brown
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Ricardo Ryan
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